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About Projects Module
The Projects module enables administrators to configure all project members to view key project information. It 
houses important details of the project such as the address, project-related web links, and the project's start 
and target dates. It also provides the ability to set some fundamental project settings like calendar exceptions 
and custom fields. Project managers may choose to include renderings of the completed project and project-
related URL's for convenient access to additional resources. This module also provides a means for par-
ticipants to message one another.

Account and project administrators will use this module to create additional projects in Trimble Unity Construct 
as they are created in the field. Many of the features of Projects are targeted to the administrator's role of set-
ting up project details and managing project participants  level of access, their group and role associations.

Access Project Details Page
There are two ways to access the Project Details page. The first method is from the Top Navigation tabs, 
which should be used if you are not already in a project. However, if you are in another module within the same 
project, the best method of access is from the Project Menu, which will eliminate the need to reselect your pro-
ject.

To choose a project
 1. Click Projects from the top navigation tabs.
 2. Choose a project from the All Projects menu.

The Project Details page is displayed.

To remain in the current project

If you are already within a project, you can access the Project Details page via the Project Menu located in the 
Left Navigation Pane.

 l Click Details.
The Project Details page is displayed.

Access Project Participants Page
There are two ways to access the Project Participants page. The first method is from the Top Navigation tabs, 
which should be used if you are not already in a project. However, if you are in another module within the same 
project, the best method of access is from the Project Menu, which will eliminate the need to reselect your pro-
ject.

To choose a project

 1. Click Projects from the top navigation tabs.
 2. Choose a project from the All Projects menu.

The Project Details page is displayed.

 3. From the Project Menu, click Project Participants.

To remain in the current project
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 1. Open the project.
 2. From the Project Menu, click Details.

Access Manage (Project) Form Types Page
The Manage Form Types page is only accessible by account and project administrators. There are two ways 
of accessing this page. The first method is from the Top Navigation tabs, which should be used if you are not 
already in a project. However, if you are in another module within the same project, the best method of access 
is from the Project Menu, which will eliminate the need to reselect your project.

To choose a project
 1. Click Projects from the Top Navigation tabs.
 2. Choose a project from the All Projects menu.

The Project Details page is displayed.

 3. From the Project Menu, click Manage Form Types.

To remain in the current project

If you are already within a project, you can access the Manage Form Types page via the Project Menu located 
in the Left Navigation Pane.

 l From the Project Menu, click Manage Form Types.

Add New Projects

Trimble Unity Construct Projects represent actual projects going on in the field and are typically created just as 
soon as a decision is made to move forward on a project. The sooner a project is created in Trimble Unity Con-
struct, the more lead time administrators have to set up project roles and permissions to prepare for user 
access.

To add a new project

 1. Click the Setup tab from the Top Navigation tabs.

Note: If the Setup tab is not visible, click the drop-down arrow next to your username and click Setup.

 2. In the My Settings section, expand Membership, and then click Projects.
 3. Click Add Project.

The Add Project page is displayed.

 4. Complete all necessary fields.
 5. Click Save.

Related Topics:
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 l Add/Edit Project Page Overview

Edit Project Details

Project details can be modified throughout the life of the project and are necessary when key project inform-
ation changes, such as project status, start and target dates, project administrators, custom fields and various 
other settings. For a list of all editable settings, see Add/Edit Project Page Overview.

To edit project details

 1. Go to the Project Details Page.
For instructions, see Access Project Details Page.

 2. Click Edit.
The Edit Project page is displayed.

 3. Complete all necessary fields.
 4. Click Save.

Bulk Edit Project Details
Bulk Edit Project Fields

Making updates to project fields across many projects is now vastly more efficient. When you have a lot of 
updates to make, such as changing the Status or Target Date for multiple projects, it can be done at once in a 
bulk action. For example, update a custom field across 50 projects from the Project Details page with just a few 
clicks. The Bulk Edit capability is accessible anyplace you can edit projects.

Bulk Edit applies to updates of Project fields and Custom fields.

Permissions considerations: to perform Bulk Edits the user must have permission to update the field. The fol-
lowing permissions are validated:

 l Add/edit project
 l Custom field permissions

Upper Limits: Bulk Update enables updates across up to 50 projects for up to 25 fields at a time.
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Real World Scenario  Project Status Meeting Requires High Volume Updates

New information in a project status meeting require 50 projects to have their Status and Phase values updated 
in e-Builder. Rather than updating each project separately, which would take 4 clicks per project and poten-
tially take more than an hour. With Bulk Edit, all 50 projects may be selected at once and the update take a mat-
ter of minutes.

Applying Bulk Edit

 1. Access Bulk Edit from Administration Tools > Projects > Manage Projects, or by clicking the Projects 
tab to access the Projects page, or My Settings > Membership > Projects

 2. Select the Projects to be updated by clicking the check box next to the project and click the Bulk Edit but-
ton. Note you may select up to 50 projects at a time.

 3. Select the Fields to be updated utilizing the Available fields filter or typing the name of the field in the 
input box

 4. Update the value of each field individually if the values are different or click Apply to All if the same field 
value applies across projects.

 5. Click Save. A confirmation message will appear when updates are successful or a warning if one of the 
entries is invalid.

Enable Project Document Control

Document control must be enabled first at the account level by the administrator, and also at the project level 
to allow users to complete document custom fields. 

Even when document custom fields are available at the account level, this setting must be enabled on the indi-
vidual project so that document custom fields are visible to participants.

To enable document control

 1. Go to the Project Details page.
For instructions, see Access Project Details Page.

 2. Click Edit.
 3. Click the Settings tab.
 4. In the Project Settings section, select Yes in the Enable Document Control? field.
 5. Click Save.

Tip: After account-level Document Control is enabled, all new projects will have the project-level Document 
Control also enabled by default ("Yes"). However, the setting must be enabled individually for previously cre-
ated projects.

Related Topics:
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 l Project Details Page Overview
 l Add/Edit Project Page Overview
 l Enable/Disable Account Document Control (Admin)

Make Form Types Accessible/Inaccessible

Administrators have the ability to choose the form types to make available in their projects. When forms types 
are created at the account level, account administrators make projects assignments, but these can be mod-
ified at the project level as described below:

 1. Go to the Manage (Project) Form Types page.
For instructions, see Access Manage (Projects) Form Types Page.

 2. To make form types accessible in the projects, select the form type from the Not Applied to this Site 
panel and click the right directional arrow to add it to the adjacent Applied To This Site panel.
—Or—
To make form types inaccessible from your projects, select the form type from the Applied to this Site 
panel and click the left directional arrow to add it to the adjacent Not Applied To This Site panel.

 3. Click Save.

Related Topics:
 l Manage (Projects) Form Types Page Overview

Export Project Address Book

The project address book includes the contact information of all project participants. This information can be 
exported in two formats: as a VB script, which will add participants to a folder in the Microsoft Outlook contacts 
and secondly as an Excel spreadsheet.

To export the project address book

 1. Go to the Project Details page.
For instructions, see Access the Project Details Page.

 2. Click Export Address Book.
The Export Address Book window displays.

 3. To create a folder in your Outlook contacts, select VB Script (Outlook Only).

enable_document_types.htm
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—Or—
To generate an Excel spreadsheet, select Comma Separated Values.

 4. Click Save.

View Sent Messages

Administrators have access to outbound messages sent by their project participants, which are often useful 
during auditing. All outbound messages sent by project members are searchable, including  invitations to bid,  
email messages and notifications.

To search for and view outbound project participant messages

 1. Access the Projects module.
For instructions, see Access Project Details Page.

 2. From the Project Menu, click Sent Items.
All outbound messages display in the results table.

 3. To filter specifically for items that meet certain criteria, complete some or all of the filter options.
 4. Click Filter.

Related Topics:
 l Sent Items Page Overview

Attach Documents to Project Details
Documents may be added to project details for recording keeping or to provide supportive information when 
necessary. Project charters or a project narrative for example might be attached to give participants insight 
into the initiatives that forged the project.

Note: Project attachments are viewable by all project members. To add restrictions, store files in the Docu-
ments module where you can edit folder permissions.

Tip
In IE 10, Firefox, Chrome, and Safari browsers, you can simply drag and drop documents from your local 
directory onto the Content Pane of the selected folder. Also, throughout e-Builder Enterprise, you can drag 
and drop files onto the Attached Documents tab using any of the aforementioned browsers.

Note: If you're not using the drag and drop feature, there are two methods for uploading documents: single 
file upload and multi-file upload. The latter allows you to drag and drop multiple files from your local machine 
onto the Upload Documents window. With single file upload, you're able to upload one file at a time. This is 
the default method, but you're able to switch between the two. A link for switching between the upload meth-
ods appear in the upper-right corner of the Upload Documents window when you start the document upload 
procedure.

To attach documents to project details using multi-file upload

sent_items_page_overview.htm
folder_permissions.htm#EditFolderPermission
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 1. Go to the Project Details page.
For instructions, see Access the Project Details Page.

 2. Click the Documents tab.
 3. Click Attach Documents. The Attach Documents window appears.
 4. To attach files from your computer, click Browse For Files.... to search for and select files. In the 

Destination Folder field, click Browse to select a folder from the e-Builder folder structure.
—Or—
To attach files from the e-Builder Document module, click Attach files from the e-Builder Document 
module for the project. Click Browse For Files to search for and select file.

 5. Click Attach Selected.

Attach Forms to Project Details
Forms can be attached to Project details as a record of the events that culminated the project. Examples 
include inspection and master permit forms.

Note: All project detail attachments are viewable by project members. Confidential forms should not be 
attached here. To learn more, see View Form Permissions.

To attach forms to project details

 1. Go to the Project Details page.
For instructions, see Access the Project Details Page.

 2. Click the Forms tab.
 3. To fill out a form, click Fill Out Form.

The Fill out Form window appears. Select the form you want to fill out. Complete the form, and click 
Post Form.
—Or—

To attach a completed form, click Attach Forms.
The Attach Forms window appears. Search for and select a form. Click Attach.

Attach Processes to Project Details
Documents may be added to project details for recording keeping or to provide supportive information when 
necessary. For example, a project approval process or project funding authorization process might be 
attached.

To attach processes to project details

 1. Go to the Project Details page.
For instructions, see Access the Project Details Page.

 2. Click the Processes tab.
 3. Click Attach Processes.

The Attach Processes window appears.

view_form.htm#View
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 4. Search for and select a process.
 5. Click Attach.

Add/Remove Project Members

Project membership is necessary for participants to access and work in the project. Participants can be added 
to a project at any time. Removing users from the project will revoke all their access to project data. Effectively, 
the project will no longer display in their list of projects to choose from.

To add or remove users from a project

 1. Go to Project Settings.
For instructions, see Access Project Settings.

 2. In the Administration Tools section, click Manage Users.
 3. Click the name of the person whose membership you want to manage.

The User Details page is displayed.

 4. Click Manage Membership.
The Manage Membership for [user name] page is displayed with the Projects tab highlighted.

 5. To make the person a member of a project, select the project from the All Projects panel and click the 
right directional arrow to add the project to the Projects That User is a Member Of panel.

Note: Users with Manage Users permission will only see the projects that they administer listed in the 
All Projects panel.

—Or—
To remove users from the project, select the user's name from the Projects That User Is A Member Of 
panel and click the left directional arrow to add them to the All Projects panel.

 6. Click Save.

Manage Project Member Permissions

Note: Account administrations can modify permissions for the account from the Setup module. Project 
administrators can manage the individual project permissions by giving additional access rights, but project 
administrators cannot remove permissions.

access_project_settings.htm
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Permissions can be managed per project role or for the individual user. Role permissions allow you to modify 
permissions for everyone in a select role, while individual permissions allow you to grant specific users addi-
tional access independent of the roles to which they belong.

To modify user permissions from the Projects module

 1. Click Projects from the Top Navigation tabs.
 2. Choose a project from the All Projects menu.

The Project Details page is displayed.

 3. From the Project Menu, click Manage Permissions.
 4. To manage role permissions, within the Roles section, select the appropriate module tab and select the 

permission you wish to grant.
—Or—
To manage individual user permissions, select the appropriate module tab, scroll down to the Users 
section and select the permission you wish to grant.

Note: For a description of each permission setting, see Manage Project Permissions Page Overview.

 5. Click Save Changes.

Reassign Work - Projects

Administrators have the ability to reassign work from one team member to another. While any administrator 
can do this, it is typically done by the project administrator. There are several reasons why this may be neces-
sary; such as if the user's roles have changed; workload needs to be reallocated; the resource is on vacation, 
out sick or no longer available. Anything that is assigned to a resource can be reassigned, such as schedule 
tasks and workflow forms.

To reassign work

 1. Go to the Project Participants page.
 2. From the Groups section, click the title of user's associated group.
 3. In the Content Pane, select the check next to user you want to reassign work from.
 4. Click Reassign Work.

The Reassign Work Items page is displayed.

 5. Select the check box next to the task(s) to reassign.
 6. Click the Select a user to reassign work to drop-down arrow to select the user to reassign items to.
 7. Click Reassign.
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Send Messages

All project participants have the ability to send messages to fellow members of the project. All outbound mes-
sages will be searchable from the Sent Items page.

To send messages from the Projects module

 1. Go to the Project Participants page.
For instructions, see Access Project Participants Page. By default a list of all project members display 
in the Content Pane.

 2. To send a message to project members, select the check box next to the user's name.
—Or—
To select users from a specific group, select the group name from the Groups section, and then select 
the check box  next to the user's name.
—Or—
To select users from a specific role, select the role name from the Roles section, and then select the 
check box next to the user's name.

 3. Click Send Message.
The Email Users window appears.

 4. Complete all necessary fields.
 5. Click Send.

Related Topics:
 l Email Users Window Overview

Create Groups

The Administrators and Members groups are available by default. Members of the Administrators  group have 
project administrator permissions. Additional groups can be created to help you categorize users in a way that 
is more meaningful to your organization. Document permissions can be assigned to groups and forms can 
also be sent to groups.

Note: Please be aware that regardless of the groups users belong to, permissions will still be based on roles 
and individual user permissions.

Example
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You might create a Safety Correspondents group that would allow you to communicate solely with the Con-
tractor's Superintendent, Managing Contractor and Resident Engineer. This would be a more effective 
method of communicating, as opposed to sending a safety violation form, for example, to a particular role or 
having to pick these team members from a list of users. Furthermore, if this form and associated doc-
uments are stored in an e-Builder folder, permissions can be specified for this particular group.

To create a new group

 1. Go to the Project Participants page.
For instructions, see Access Project Participants Page.

 2. In the Groups section, click Create.
 3. In the Group Name field, enter a name.
 4. Click Save.
 5. To add members to the group, click Manage this Group in the Content Pane.

The Manage Users window appears.

 6. Select users to add to the group from the Project Users panel.
 7. Click the right directional arrow to move selected users to the adjacent panel.
 8. Click Save.

Related Topics:
 l Rename Groups
 l Project Participants Page Overview

Rename Groups

The Administrator and Members groups are available by default and cannot be altered. However, additional 
groups can be created and if necessary, renamed.

To rename a project group

 1. Go to the Project Participants page.
For instructions, see Access Project Participants Page.

 2. In the Groups section, select the check box next to the group.
 3. Click Rename.
 4. Enter a new name in the Group Name field.
 5. Click Save.

Related Topics:
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 l Create Groups
 l Delete Groups
 l Project Participants Page Overview

Delete Groups

The Administrator and Members groups are available by default and cannot be deleted or renamed. However, 
all other groups can be deleted if necessary.

To delete a project group

 1. Go to the Project Participants page.
For instructions, see Access Project Participants Page.

 2. In the Groups section, select the check box next to the group.
 3. Click Delete.

You are prompted for confirmation.

 4. Click OK.

Related Topics:
 l Create Groups
 l Rename Groups
 l Project Participants Page Overview

Add Members to Project Roles

Trimble Unity Construct permissions are contained in roles. Roles exist at the account level, but project level 
roles can also be applied, which will allow you to give users the permissions of the select role for specific pro-
jects only. Adding a user to a role from the Project Participants page automatically adds them to the role for 
that project. If you wish to add users to account roles - which will give them the permissions of the role on all 
projects - you can do so from the Manage Users or Add Users page. For instructions, see Add Users to 
Account Roles.

To add users to a project-specific role

 1. Go to the Project Participants page.
For instructions, see Access Project Participants Page.

 2. Select the role from the Roles section.

admin-account-role.htm#AddUserAccount
admin-account-role.htm#AddUserAccount
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 3. Click Add User.
 4. Select the check box next to the users you want to add to this role.
 5. Click Add User.

A check mark is placed in the Project Role column, indicating that users are in this role at the project 
level.

Related Topics:
 l Project Participants Page Overview
 l About Project Level Roles

Add Members to Project Roles

Trimble Unity Construct permissions are contained in roles. Roles exist at the account level, but project level 
roles can also be applied, which will allow you to give users the permissions of the select role for specific pro-
jects only. Adding a user to a role from the Project Participants page automatically adds them to the role for 
that project. If you wish to add users to account roles - which will give them the permissions of the role on all 
projects - you can do so from the Manage Users or Add Users page. For instructions, see Add Users to 
Account Roles.

To add users to a project-specific role

 1. Go to the Project Participants page.
For instructions, see Access Project Participants Page.

 2. Select the role from the Roles section.
 3. Click Add User.
 4. Select the check box next to the users you want to add to this role.
 5. Click Add User.

A check mark is placed in the Project Role column, indicating that users are in this role at the project 
level.

Related Topics:
 l Project Participants Page Overview
 l About Project Level Roles

Remove Members from Project Role

about_project_level_roles.htm
admin-account-role.htm#AddUserAccount
admin-account-role.htm#AddUserAccount
about_project_level_roles.htm
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As team members take on new roles within an organization, it's important for administrators to also keep role 
memberships up-to-date in order to ensure participants have access only to data that is appropriate for their 
roles.

To remove users from a project role

 1. Go to the Project Participants page.
For instructions, see Access Project Participants Page.

 2. Select the role from the Roles section.
 3. In the Content Pane, select the check box next to the user(s) you want to remove from the role.

Note: 
A check mark in the Account Role column indicates that the user in this is role at the account level. If 
this is the case, removing them from the project role will have no effect. You must remove users from 
the account role before you're able to restrict their project role permissions.

 4. Click Remove User.
You are prompted for confirmation.

 5. Click OK.

Related Topics:
 l Project Participants Page Overview
 l About Project Level Roles

Apply Project Role Templates

Project role templates can be applied to a project from two different locations; The Project Participants page 
and the Apply Templates page. Project Role Templates give administrators a way to predefine the roles that 
will be applied to different.

admin-account-role.htm#Remove
admin-account-role.htm#Remove
about_project_level_roles.htm


Trimble Unity Construct

Page 17

Example
PM1 may be the lead on all Campus projects, but PM2 is the lead on all Medical Center projects. Using pro-
ject level role templates is a quick and easy way to apply project roles across your different project types.

In addition to being added to the template, users must also be members of the project for the template to take 
effect. Otherwise, non-project members will be ignored. For instructions, see Add User to Projects.

To apply project role templates

 1. Click the Projects tab on the Top Navigation Tabs.
 2. Select a project from the Projects drop-down menu.
 3. From the Project Menu, click Project Participants.

Tip
Click the Members link to ensure that the users in the project role template are also project mem-
bers.

 4. Click Apply Role Template.
The Select Role Template dialog box displays.

 5. Click the drop-down arrow to select the role template you want to apply.
 6. Click Apply.

A success message displays.

Related Topics:
 l About Project Level Roles

Projects Page Overview
The main Projects page can be customized with views, which will allow you to display only the information you 
need, based on selected views. From here, administrators and users with Add New Project permissions can 
also add new projects. For instructions on adding project views, see Add Views.

Add/ Edit Project Page 
The Add/Edit Project page allows administrators and users with Add New Project permissions to add a new 
project and those with the Update Project Details permission to modify the details of an existing project. 

Projects within e-Builder represent actual projects going on in the field and they are typically created just as 
soon as a decision is made to move forward on a project. The sooner a project is created within e-Builder, the 
better, as this will give account and project administrators enough lead time to set up project roles and per-
missions so project members can start contributing right away. Most of the details of a project can be modified 
at any time, which may be necessary if there's a new project administrator or the status of the project has 
changed, for example.

For instructions on how to access the Add Project page and add a new project, see Add New Projects. For 
instructions on how to access the Edit Project page and edit the project details of an existing project, see Edit 
Project Details.

The toolbar buttons and project settings available at the top of the Add/ Edit Project page are:

manage_membership_page.htm#GrantProjectAccess
about_project_level_roles.htm
addedit_user_page_overview.htm
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Toolbar Buttons
 l Check Spelling: Click to check the spelling of form field entries.
 l Save: Click to save any changes.
 l Cancel: Click to discard changes.

Details Section
 l Project Name: Enter the project name.
 l e-Builder Project Administrator: If the project setting is configured to default to a specific project 

role, only users in that role display for you to choose from. See Complete Project Settings for more 
information. If user options do not already display, choose an administrator for this project.

 l Description: Enter a description of this project. This can be used to give project administrators and 
members of the project additional information about the project.

 l Project Status: Choose a project status from this drop-down menu. Default statuses are available, 
but the list of statuses may be customized by account administrators. For more on this setting, see 
Managing Project Statuses.

 l Project Photo: Click Browse to select a picture of this project.
 l Address: Enter the address of the project site. This information will be available from the Project 

Details page.
 l City: Enter the city location of the project site.
 l State / Province: Enter the state location of the project site.
 l Zip / Postal Code: Enter the zip code of the project site.
 l Country: Enter the country of the project site.
 l Map location: Click Choose from map to add the map location for this project. This can be set to a 

different location than the project address. Click XYZ coordinates to view the coordinates along the 
three axes.

 l Start Date: Enter the date that the project will begin.
 l Target Date: Enter the date that the project is scheduled to end.
 l Project Webcam URL: If available, enter the URL of the webcam at the project site.

The tabs available on the Add/ Edit Project page are:

Custom Fields Tab

If there are project custom fields available, they display on this tab. Custom fields allow you to group or filter 
information according to specific business processes in your reports. For more information, see About 
Global Custom Fields.

Settings Tab

Project Settings
 l Project Access:

 o Yes - This is the default selection. Select this option to allow users to log in to this project.
 o No - Select this option to restrict users from logging into this project. If a project is still 

being set up, administrators may choose to temporarily restrict access.

complete_project_settings.htm
about_project_statuses.htm
about_global_custom_fields.htm
about_global_custom_fields.htm
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 l Deny Techsupport Access?: 
 o Yes - Select this option to disallow e-Builder technical support from accessing this project. 

Tech Support access may be necessary for troubleshooting issues users might exper-
ience. However, projects that include confidential content may need to be restricted.

 o No - This is the default selection. Select this option to allow e-Builder technical support to 
access this project whenever necessary. Tech support might need access to assist users 
when troubleshooting issues that might arise.

 l Enable Document Control?: Document control makes document custom fields available on a 
project. Even if document custom fields exists, unless this setting is enabled, users will not be 
able to complete these fields on a project.

 l Equipment Management Tool Integration?: The Equipment Management feature allows you 
to keep track of the costs associated with items that have been purchased by the owner and 
installed by either the owner or a contracting company. Optionally, equipment purchases can be 
tied to commitments for a more accurate representation of project costs. To learn more, see 
About Equipment Items.

 o Yes - Select to enable equipment management integration on this project. This setting will 
restrict the Equipment Manager feature so that all updates to the equipment list can only 
be done outside of e-Builder. This feature would be used strictly for budgeting and viewing 
the equipment list and the status of equipment items. When this setting is enabled, the 
equipment list cannot be compiled or managed in e-Builder, but items can still be tied to 
the budget.

 o No - This is the default selection. Select to maintain full use of the Equipment Man-
agement feature.

 l Plan Room Access: This setting allows you to determine how the plan room will be accessed. 
For more information, see About the Plan Room.

 o None - This is the default selection. Select to restrict all access to the plan room.
 o Internal Only - Select to limit plan room access only to those users who can access e-

Builder. If this option is selected, users will only to able to access the plan room through e-
Builder; a URL will not be generated.

 o Public - Select to automatically generate a URL from which users can access the plan 
room. After changes are saved, this URL displays in the External Plan Room URL field loc-
ated on the Project Details page.

 o Shared Password - Select to create a shared password for users to enter when access-
ing the plan room.

 1. Enter a password in the Shared Password field.
 2. Re-enter this password in the Confirm Password field.

Project Currency

This section is displayed only if the multi-currency feature is enabled for the account. This section is vis-
ible only to users with View Cost permissions.

about_equipment_items.htm
introduction.htm
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 l Project Currency: Select the currency to use for the project. The project currency indicator (cur-
rency code) will be displayed on the top of every Cost page. The project currency is set to the 
account currency by default if no project currency has been specified during project creation. 
This setting can be edited by Project Administrators and can be changed to any of the pre-
defined currency types on the account as long as there is no cost data set up (eg., line items or 
funding allocation).

Tip: To find a currency quickly, enter the currency name in the Project Currency text box and 
select it from the search results.

Workflow Settings
 l Workflow Due Date Offset: Enter the number of days that the workflow forms are due after it 

has been initiated. For example, if workflow forms should be submitted, within seven days of 
being received, enter "7" in this field.

Project Calendar

This setting allows you to configure calendar settings, which will influence the project calendar and 
schedule.

 l Work Day Start Time: Enter the time that the work day will begin for this project.
 l Work Day End Time: Enter the time that the work day will end for this project.
 l Work Week: Choose the days of the week that will make up the work week for this project.

Calendar Exceptions

This section allows you to determine the days that will be treated as an exception to the general rule, 
such as holidays that fall on typical working days. From this page you can choose particular dates and 
mark them as working or non-working days. Identifying these days at the onset of a project helps man-
agers plan more effectively.

 l Date: Enter a date to add as an exception or click the calendar icon to choose one directly from 
the calendar. In the adjacent box, choose whether this is a working or non-working day.

 l Add: Click to add the entered date exception to the list of calendar exceptions.
 l Delete: Click to delete the selected calendar exception date.

Project Details Page 
The Project Details page may be the most frequently viewed page among project members, as it provides key 
information about the project, such as project name, the administrator, the status of the project and the start 
and target dates, for example. All project participants have access to this page, although certain data will be 
exclusive to administrators and users with certain project permissions. 

The toolbar buttons and sections on the Project Details page are:

Toolbar Buttons
 l Export Address Book: Click to export the project address book either as a VB Script, which can be 

used to import contacts into Outlook or an Excel spreadsheet.
 l Printable Participants Directory: Click to generate a printable directory of project participants.
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 l Edit: This button is only available to administrators and users with Update Project Details per-
missions. Click to edit project details.

 l Cancel: Click to discard changes.

Details Section
 l Project Name: Displays the name of the project.
 l e-Builder Project Administrator: Displays the name of the project administrator.
 l Description: If available, displays a description of this project. 
 l Project Status: Displays the status of the project.
 l Address: Displays the address of the project site..
 l Country: Displays the country where the project is taking place.
 l Start Date: Displays the date that the project will begin.
 l Target Date: Displays the date that the project is scheduled to end.
 l Project Webcam: If available, displays the URL of the webcam at the project site.
 l Web Links: If available, displays the web address of a project-related website.

The tabs on the Project Details page are:

Custom Fields tab

If there are project custom fields available, they display on this tab. Custom fields allow you to group or filter 
information according to specific business processes in your reports. For more information, see About 
Global Custom Fields.

Project level options are available for projects that have a Drop Down, Multiple Pick, Radio Button or a 
Checkbox data type selected. This is available for custom fields and Process Data Fields only. When con-
figuring a field of one of these types, you now have the ability to set the options at the:

 l Account Level
 l Project Level: Options can be different project by project

Notes tab

This tab displays all available notes and allows you to add new notes about the project. Once notes are 
added, they cannot be edited or deleted. Users with 'Manage Private Notes permissions are able to add 
and view private project notes.

Documents tab

This tab displays all documents that have been attached to this project. From here you are also able to 
attach documents to the project. For instructions, see Attach Documents to Project Details.

Forms tab

This tab displays all forms that have been attached to this project. From here you are also able to attach 
forms to the project. For instructions, see Attach Forms to Project Details.

Processes tab

manage_permissions_page.htm
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This tab displays all processes that have been attached to this project. From here you are also able to 
attach processes to the project. For instructions, see Attach Processes to Project Details.

Settings tab

Project Settings 
 l Project Access: This field is visible only to administrators and users with Update Project Details 

permissions. This setting indicates whether or not users are allowed to log in to the project. If a 
project is still being set up, administrators may choose to temporarily restrict access.

 l Deny Techsupport Access?: Indicates whether or not e-Builder Technical Support is able to 
access this project. Tech Support access may be necessary for troubleshooting issues users 
might experience. However, projects that include confidential content may need to be restricted.

 l Enable Document Control: This field is visible only to administrators and users with Update Pro-
ject Details permissions. This setting indicates whether or not document control is enabled. Docu-
ment control allows document custom fields to be completed on a project. Even if document 
custom fields are available, unless this setting is enabled, users will not be able to complete 
these fields on a project. For more information, see Add Document Custom Fields.

 l Plan Room Access: Displays the level of access for the Plan Room. For more information on 
this feature, see About the Plan Room. Options include the following:

 o None: Access to the Plan Room is restricted.
 o Internal: Plan Room access is limited to licensed e-Builder users only. Users are only 

able to access the plan room through e-Builder; a URL is not generated with this access 
type.

 o Public: The Plan Room is publicly enabled and can be accessed via the URL that 
appears in the following External Plan Room URL field.

 o Shared Password: The Plan Room can only be accessed using a password, which can 
be obtained by an account or project administrator.

 l Equipment Management Tool Integration?: Indicates whether or not the project is integrated 
with a third party equipment management tool. For more information, see About Equipment 
Items.The options are as follows:

 o Yes: This project is integrated with a third-party equipment management tool; therefore 
the use of this feature within e-Builder is limited. Updates to the equipment list can only be 
done outside of e-Builder. Within e-Builder, this feature can only be used for budgeting 
and viewing the equipment list and the status of equipment items.

 o No: This project is not integrated with a third-party tool and maintains full use of the Equip-
ment Management feature.

Workflow Settings
 l Workflow Due Date Offset: Enter the number of days that the workflow forms are due after it 

has been initiated. For example, if workflow forms should be submitted, within seven days of 
being received, enter 7 in this field.

Project Currency

add_document_custom_fields.htm
introduction.htm
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This section is displayed only if the multi-currency feature is enabled for the account. This section is vis-
ible only to users with View Cost permissions.

 l Project Currency: Select the currency to use for the project. The project currency indicator (cur-
rency code) will be displayed on the top of every Cost page. The project currency is set to the 
account currency by default if no project currency has been specified during project creation. 
This setting can be edited by Project Administrators and can be changed to any of the pre-
defined currency types on the account as long as there is no cost data set up (eg., line items or 
funding allocation).

Tip: To find a currency quickly, enter the currency name in the Project Currency text box and 
select it from the search results.

Project Calendar

This section includes general information about the project's calendar, such as the start and end times 
of the work day and the days that make up the work week. These settings influence the project calendar 
and schedule modules only. They do not affect due dates and escalation calculations in areas such as 
processes, submittals and forms.

 l Work Day Start Time: Displays the time that the work day begins.
 l Work Day End Time: Displays the time that the work day ends.
 l Work Week: Displays the days of the week that makes up the work week.

Calendar Exceptions

This section lists all the days that are treated as exceptions to the general rule, such as holidays that fall 
on typical working days. Knowing these days early on allows you to plan effectively. Calendar Excep-
tions can also be created at the account level by the administrator. These exception dates apply to every 
project in the account.  When you edit the Settings tab, exceptions with a grayed out checkbox are 
account level and cannot be changed.

Note: If the Multiple Calendar or Resource Management features are activated, then Calendar Excep-
tions from Project Details are no longer connected to the schedule module.  Non-working time is 
defined on each individual calendar from the Working Time button on the schedule toolbar.

Apply Project Templates Page 
After a project is created, administrators can apply a project template to get the new project set up more 
quickly. Templates are a compilation of structures from other areas of e-Builder Enterprise that can be applied 
to your current project. Certain projects may share similar characteristics which makes a particular template 
appropriate for multiple projects. For example, public school projects might have the same project managers, 
administrators, facilities managers, and finance directors, which would allow you to reuse the same template
(s) for all projects of this nature. Available templates are as follows:

 l Project Templates (Document folder structure)
 l Role Templates
 l Schedule Templates

calendar_exceptions_page.htm
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 l Budget Templates
 l Cash Flow Templates
 l Funding Templates

Fields and Buttons

The fields and buttons located on this page are:
 l Apply Templates : Click to apply selected templates.
 l Cancel: Click to discard changes.
 l Select a project template: Projects selected from this menu will be used as a template for your selec-

ted project. After choosing a project, you'll have the option to copy all or some of the following sets of 
information:

 o List of users
 o Project groups
 o The Documents folder structure including documents, permission settings, folder subscriptions 

and custom fields
 o Calendar setting exceptions

 l Select a role template: Click the drop-down arrow to select a role template. The content of each tem-
plate may differ, but Role templates typically include a list of roles and users that belong to each role.

 l Select a schedule template: Click the drop-down arrow to select a schedule template. The content of 
each template may differ, but schedule templates can include the following:

 o List of tasks
 o Duration of each task
 o Task predecessors
 o Task resource role
 o Manager role
 o Whether or not approval is required for changes to task dates
 o Whether or not approval is required before a task can be marked complete
 o List of master tasks and master processes.

 l Select a budget template: Click the drop-down arrow to select a budget template. For more inform-
ation, see Working with Budget Templates. 
The content of each template may differ, but budget templates can include the following:

 o Budget line items
 o Account codes
 o Formulas
 o Whether or not charges are allowed
 o Whether or not approval is required for budget changes

 l Select a cash flow template: Click the drop-down arrow to select a cash flow template. The content of 
each template may differ, but cash flow templates are based on selected budget template line items, 

about_schedule_templates.htm
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they may also be linked to schedule templates. For more information, see Working with Cash Flow Tem-
plates.

 l Select a funding template: This option will only be available if advanced funding is enabled on the 
account. Click the drop-down arrow to select a funding template. These templates include a list of fund-
ing sources. For more information, see Working with Funding Templates.

Project Participants Page 
The Project Participants page lists all members of the project including available groups and roles. This page 
allows account and project administrators to take the actions listed below. All project members however are 
able to view user details and email fellow project participants.

The following actions can be taken from this page:
 l Add/ Remove Project Members
 l Create Groups
 l Rename Groups
 l Delete Groups
 l Send Messages
 l Remove Users from Project Role
 l Reassign Work
 l Apply Role Templates

Note: Keep in mind that some of the actions listed below are permissions based.

Fields and Buttons

The fields and buttons located on this page are:

Groups
 l Create: This link is only enabled for account and project administrators. The Administrators and 

Members groups are available by default and members of the Administrators group have project 
administrator permissions. Click to create a project group. Creating additional groups will help you 
better organize project members.

 l Rename: This link is only enabled for account and project administrators. Click to rename existing 
groups.

 l Delete: This link is only enabled for account and project administrators. Click to delete selected 
groups. The Administrators and Members groups are available by default and they cannot be 
deleted. Please note that if a group is deleted, the members of that group will not be removed from 
the account.

 l Administrators: Displays by default. Members of this group have administrative access to the pro-
ject. This group cannot be deleted or renamed. Click to see all members of the Administrator group.

 l Members: Displays by default. This group includes all project members and cannot be deleted or 
renamed. Click to see all members of this group.

Roles

working_with_cash_flow_templat.htm
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This section lists all available roles on the project. Click a title to see the members of the role in the adjacent 
Content Pane. All users are able to send messages to these members, but administrators are also able to 
add or remove users from a role on the project level.

Content Pane

The data that displays in the content pane is contingent on what is selected in the Groups/ Roles section loc-
ated on the left side of the page. Before anything is selected, a list of all project members display in this 
area.

Filter
 l First name: Enter the first name of a user to filter for a specific person, or persons with the same first 

name.
 l Last Name: Enter the last name of a user to filter for a specific person, or persons with the same last 

name.
 l Username: Enter a username in this field to filter for a specific person.
 l Company: Enter a company name to filter for users associated to a specific company.
 l Custom Field: To filter users associated with a particular custom field, make a selection from this 

drop-down menu.
 l Filter: Click to filter for entered criteria.
 l Clear: Click to clear the fields in the filter.

Content Pane - Members Group

These fields and buttons are specific to the Members group. A list of project members is the first to display 
when this page is accessed, before anything is selected. The members group cannot be deleted or 
renamed. It simply provides a list of all project members.

 l Manage Users: This button is only visible to account administrators and appears when the Mem-
bers group is selected. Click to open the Manage Users window where you can take any of the fol-
lowing actions:

 o Add New Users to Account
 o Add Users to the Project
 o Remove Users from Project

 l Send Message: Click to send a message to selected users. The Email Users window appears.
 l Remove from Project: This button is only visible to account and project administrators. Click to 

remove selected users from the project.
 l Reassign Work: This button is only visible to account and project administrators. Click to reassign 

work items for a selected user. The Reassign Work Items page is displayed. For instructions, see 
Reassign Work.

 l Apply Role Template: This button is only visible to account administrators. Role templates are cre-
ated by account administrators and can be used to quickly set up role permissions and project 
access. For instructions, see Apply Role Templates.

 l Name: This column displays the user's name. Click to open the User Details page.

manage_users.htm
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 l Username: This column displays the user's username.
 l Company Name: This column displays the company that the user is associated with.
 l Date Added: This column displays the date that the team member was added to the project.

Content Pane - Group

This section lists and describes the fields and buttons that display when a particular group is selected.
 l Manage this Group: This button is only visible to account and project administrators and appears 

when a group other than Members is selected. Click to open the Manage Users window where you 
can take any of the following actions:

 o Add New Users to Account
 o Add Users to the Project
 o Add Users to the Administrator Role

 l Send Message: Click to send a message to selected users. The Email Users window appears.
 l Remove from Group: This button is only visible to account and project administrators and appears 

when a group other than Members is selected. Click to remove selected users from the selected 
group.

 l Reassign Work: This button is only visible to account and project administrators. Click to reassign 
work items for a selected user. The Reassign Work Items page displays. For instructions, see Reas-
sign Work.

 l Name: This column displays the user's name. Click to open the User Details page.
 l Username: This column displays the user's username.
 l Company Name: This column displays the company that the user is associated with.
 l Date Added: This column displays the date that the team member was added to the project.

Content Pane - Roles
 l Send Message: Click to send a message to selected users. The Email Users window appears.
 l Add User: This button is only visible to account administrators and appears when a role is selected. 

Click to add a user to the selected role at the project level. The Add Users window appears. See 
Also: About Project Level Roles.

 l Remove User: This button is only visible to account administrators and appears when a role is 
selected. Click to remove selected users from the project role. 

Note: This action does not remove users from the account, nor does it remove them from the pro-
ject. It also does not remove them from the account level role; it only removes them from the pro-
ject level role.

For more information, see:
 o About Project Level Roles
 o Remove Users from Account Level Roles

 l Name: This column displays the user's name. Click to open the User Details page.
 l Username: This column displays the user's username.
 l Company Name: This column displays the company that the user is associated with.

manage_users.htm
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 l Account Role: A check mark in this column indicates that the user is in this role on the account 
level. For more information, see:

 o Add Users to Project Roles
 o About Project Level Roles

Note: Account role permissions are applied to all projects within the account. Therefore, users in 
an account role cannot be removed from this role on the project level. To ensure that only project 
level roles are applied, remove the user from the role at the account level.

 l Project Role:A check mark in this column indicates that the user is in this role on the project level. 

For more information, see:
 o Add Users to Project Roles
 o About Project Level Roles

Manage (Projects) Form Types Page 
The Manage Form Types page in the Projects module is accessible to account and project administrators and 
it allows you to choose the form types that should or should not be available in your projects. When forms 
types are created at the account level, account administrators are able to make projects assignments, but 
these can be modified at the project level from this page. For instructions, see Make Form Types Access-
ible/Inaccessible. 

Fields and Buttons

The fields and buttons located on this page are:
 l Save: Click to save changes.
 l Cancel: Click to discard changes. All unsaved changes will be lost.
 l Not Applied to this Site: This panel lists all of the form types that are currently unavailable in the pro-

ject. To make form types available, click the right directional arrow to add the title to the adjacent 
Applied to this Site panel.

 l Applied to this Site: This panel lists all of the form types that are currently available in the project. To 
make form types inaccessible from this project, click the left directional arrow to add the title to the adja-
cent Not Applied to this Site panel.

Manage Users Window 
This window allows account administrators to add new users to the account. Users with the Manage Users  per-
mission are able to add and remove users from the project, but only from the Manage Membership page, for 
instructions, see Add/Remove Project Members. Project access can be managed from other areas of e-
Builder Enterprise, such as in the Setup module, but the Manage Users page is convenient to use when 
account administrators are already working within a project. 

Fields and Buttons

The fields and buttons located on this page are:

about_project_level_roles.htm
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 l Add New User: Click to add a new user to the account. You will be redirected to the Add New User win-
dow.

 l Available Users: This section lists all account users that are not members of the project. Pull users 
from this list to be added as project participants. Use the filter to narrow down the list of users to choose 
from. To add users to the project, select their name(s) and then click the right directional arrow to add 
them to the adjacent Project Users panel.

 o Filter Users: Use these filter options to narrow down the list of available users.
 l Removed Users: If a user is removed from the project, they will display in this panel while this window 

remains open. This allows you to review the list of removed users before saving your changes.
 l Notify users removed from site: Select this check box to send an automated message to users listed 

in the Removed Users panel, informing them that they have been removed from the project.
 l Project Users: Lists all project members. Click the left directional arrow to remove users from the pro-

ject. Doing so will revoke all access these users have to project data. Effectively, the project will no 
longer display in their list of projects to choose from.

 l Notify users added to site: Select this check box to send an automated message to users, informing 
them that they've been added to the project.

 l Include username and password: Select this check box to send usernames and passwords to newly 
added project members.

 l Save: Click to save changes.
 l Cancel: Click to discard changes.

Add Users to Role Window 
This window allows account administrators to add users to project level roles. If you wish to add users to 
account roles, you can do so from the Manage Users or Add Users page. For instructions, see Add Users to 
Account Roles.

Synopsis of Account and Project Level Roles

All roles are created at the account level. However, you do not have to add users to account roles if you wish to 
place them in different roles across multiple projects. Adding users to account roles will give them the per-
missions for that role on all projects they have access to. Project level roles however, allow you to give users in 
said role permissions for specific projects. After users are added to the project role, a check mark appears in 
the Project Role column on the Project Participants page, indicating that the user is in the select role at the Pro-
ject Level. For more information, see About Project Level Roles.

admin-account-role.htm#AddUserAccount
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Fields and Buttons

The fields and buttons located on this page are described below.

Filter Users

Use this filter to narrow down the list of users to add to the role.
 l Show/Hide Advanced Filter: Click to show or hide additional filter options as follows:

 o Email Address
 o City
 o Zip
 o Custom Fields
 o Type of Business
 o State/Province

 l First Name: Enter a first name to filter for specific users.
 l Username: Enter a username to filter for a specific user.
 l Last Name: Enter a first name to filter for specific users.
 l Company: Enter a company to filter by only those users associated with a specific company.
 l Filter: Click to filter for entered criteria.

Users
 l Add User: Click to add selected users to the role.
 l Cancel: Cancel to discard any changes and close this window.
 l Name: Displays the name of users which can be added to the role.
 l User Name: Displays the username of the corresponding user.
 l Company Name: Displays the name of the company users are associated with.
 l Date Added: Displays the date that users were added to the account role.
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Email Users Window 
The Email Users window allows you to send messages to project participants; both Trimble Unity Construct 
licensed and non-Trimble Unity Construct licensed participants. All project participants are able to access this 
page, although some functions will only be available to administrators. This window displays as a result of click-
ing the Send Message button on the Project Participants page. For instructions, see Send Messages. 

Fields and Buttons

The fields and buttons located on this page are:
 l Send: Click to send the message.
 l Cancel: Click to discard changes and close this window.
 l To: If you selected users from the Project Participants page, they display in this field. You can add addi-

tional recipients by clicking the Lookup button or typing in one email address per line.
 l Lookup: Click to search for and select additional users to message.
 l CC: Enter the email address of users to copy on the message.
 l Subject: Enter the subject of the message in this field.
 l Body: Enter your message in this field.
 l Include Welcome Message: This option is visible to account and project administrators only. Select to 

include an automated welcome message with your message.
 l Send username and password notification: This option is visible to account and project admin-

istrators only. Select to also send recipients usernames and passwords with the message.

Reassign Work Items Page 
The Reassign Work Items page allows account and project administrators to reassign work from one team 
member to another. Project administrators may have to do this when resources go on vacation, are out sick, 
change roles or are no longer available. Anything that is assigned to a resource can be reassigned, such as 
schedule tasks and workflow forms.

The descriptions for the buttons and fields on the Reassign Work Items page are:

Toolbar Buttons and Fields
 l Work Item Description: Displays the description of the item.
 l User's Involvement: Displays the user's role on the item.
 l Select a user to reassign work to....: Click this drop-down arrow to select the users to reassign 

work to.
 l Notify user: Select this check box to send a notification to the user to whom the work is reassigned.
 l Reassign: Click to reassign items, after work items and a new resource has been selected.
 l Cancel: Click to discard changes.
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Manage Form Types (Projects) Page 
This page is available to account and project administrators and allows you to choose form types to include or 
exclude from the project. When the form type is created at the account level, account administrators are able 
to make the form available in all projects or just select ones. All existing form types appear on this page in their 
respective panels, either Not Applied To this Site or Applied To This Site. Use this page to review or modify the 
list of form types that are accessible in this project. Changes made on this page will automatically adjust 
account settings and vice-versa. 

Fields and Buttons

The fields and buttons located on this page are:
 l Save: Click to save changes.
 l Cancel: Click to discard changes.
 l Not Applied to This Site: Lists the form types that are not currently accessible from this project. To 

make this form type available in this project, select it and then click the right directional arrow to add it to 
the adjacent Applied To This Site panel.

 l Applied to This Site: Lists the form types that are currently accessible from this project. To make this 
form type unavailable in this project, select it and then click the left directional arrow to add it to the adja-
cent Not Applied To This Site panel.

Project Process Notification Settings Page 
The Process Notification Settings page allows account administrators to determine which users should receive 
notifications for process instances, based on whether or not they are an actor on the step.

Fields and Buttons

The fields and buttons located on this page are:
 l Save: Click to save changes.
 l Cancel: Click to discard changes.
 l Role: Select the appropriate role to choose the team members that should receive process noti-

fications.
 l Select users to receive notifications: Users in the selected role appear in this section. Choose the 

users that should receive notifications and add them to the Selected users section.

Actor Settings for Roles with Selected Users
 l Unselected users: This section allows you to choose the users from the select role that should not 

receive notifications even when the process is in their court while including one of the following 
exceptions:

 o but will be an actor on the process - Unselected users in the role will not receive a noti-
fication, but still can take action on the process as an actor.

 o and will not be an actor on the process - Unselected users in the role will not receive the 
notification and will not be able to take action on the process, but will be 'requested comment' 
actor(s) type in the instance.
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Manage Permissions for Project
Account and project administrators can manage the permission settings for members and roles across all mod-
ules of a project. Permission settings are critical for user access rights to certain features. When troubleshoot-
ing access rights, user and role permissions should be the first area of investigation to ensure roles/users have 
appropriate access to product features. Typically, permissions are configured at the start of a project and as 
new project members are added on. 

The top portion of this page is a filter that you can use to narrow down the list of roles/users that display in the 
table below it. The second portion of this page lists all account roles, and then team members. In e-Builder, 
account roles are used to group team members, permission for both of which can be modified on this page. 

Note: Roles that appear in red are Administrator Roles. Administrator Roles are eligible to receive additional 
permissions typically reserved for the account administrator. For more information or for the list of additional 
permissions that can be granted, see About e-Builder Administrative Roles.

Filter Roles and Users

To filter by roles and/ or users

 1. In the Filter Roles and Users section, you can specify the following filter criteria:
 o Roles: Select this check box to filter for all roles. 

 n All Roles: Lists all the user roles available on the account. For instructions on adding 
account roles, see Add New Account Roles.

 n Admin Roles Only: Select this check box to filter by Admin roles.
 n Selected Roles: Lists all roles that have been selected to be included in the filter. You 

can add or remove roles from the filter to the Selected Roles box using the directional 
arrows. 

 o Users: Select this check box to filter for an individual user.
 n User Name: Enter the username of the user to filter by.
 n First Name: Enter a name in this field to filter by a user's first name.
 n Last Name: Enter a name in this field to filter by a user's last name.
 n Select a custom field: Click the drop-down arrow to select a custom field type to filter 

by. Click the Lookup button to view a list of qualifying custom fields.
 o Show All: Click to disregard filter entries and see all account roles.

 2. Click Filter. The filter results are displayed.

To access the Manage Permissions for Project
 1. Click Projects from the top navigation tabs.
 2. Choose a project from the All Projects menu.

The Project Details page is displayed.

 3. From the Project Menu, click Manage Permissions.

Permission Settings
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To grant permission to a role, select the check box for each permission. A description of the permission set-
tings available on each tab of this page is provided below.

Note: The asterisk indicates that users have to be in this role at the account level in order to inherit this per-
mission. In other words, this permission cannot be applied to a project level role. For more information, see 
About Project Level Roles.

Bidding tab
 l View Bidding: Gives users in this role the ability to view an entire bid package.
 l Create Bid Package:Gives users in this role the ability to create bid packages.
 l Modify Bidding: Gives users in this role the ability to modify bid package details. 
 l View/ Open Bid Tabulation: Gives users in this role the ability to view and open the bid tabulation.

Calendar tab
 l Create Public Project Event: Gives users in this role the ability to create public events. Everyone 

on a project is able to view public events, even if they are not an attendee of the event.

Contacts tab
 l View Project Contacts: Gives users in this role the ability to view contact details for the projects 

they have access to. 

Example
If there are 50 people in your company, but only five are working on a particular project, you may 
not want contractors to know every other contractor or A/E that you're working with.

Cost tab

Note: Cost processes do not abide by these settings. Permissions for cost processes are set on the pro-
cess properties page. For more information, see Properties Tab Overview.

 l View Cost: Gives users in this role the ability to view the overall cost summary and all cost related 
information on the projects they have access to.

 l Add/Edit Budget: Gives users in this role the ability to add and edit approved budgets and cash 
flow.

 l Add Budget Item: Gives users in this role the ability to add budget line items to approved budgets 
and budget changes.

 l Approve Final Budget: Gives users in this role the ability to approve the final budget.

Note: Users will not receive an email notification on approval requests unless the Notify user 
when approval requested setting is enabled in Cost Settings. 

 l Approve Budget Changes: Gives users in this role the ability to approve budget changes.
 l Add/Edit Commit: Gives users in this role the ability to add and edit commitment changes.
 l Approve Final Commit: Gives users in this role the ability to approve commitments.
 l Approve Commit Changes: Gives users in this role the ability to approve commitment changes 

and change commitment line items.

about_project_level_roles.htm
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 l Change Approved Commit Line Item: Gives users in this role the ability to approve changes 
made to approved commitment line items.

Example
If a commitment was accidentally saved against the Contingency budget line item, when it should 
have been saved toward General Costs, persons with this permission setting will have the ability 
to approve this change or make such changes themselves.

 l Add/Edit Actual: Gives users in this role the ability to add and edit invoices.
 l Edit Retainage of Actual: Gives users in this role the ability to manually edit item retainage 

amounts on commitment items in the 'Draft' or 'Received' status. If you select the Edit Retainage per-
mission for a role or user, the check boxes for Add/Edit Actual and View Cost permissions will also 
be selected automatically for the role or user.

 l Approve Final Actual: Gives users in this role the ability to approve invoices.
 l Change Approved Gen. Invoice Line Item: Gives users in this role the ability to approve changes 

made to approved general invoice line items.

Example
If an invoice was accidentally added toward Contingency, when it should have been added to 
General Costs, persons with this permission setting will have the ability to approve this change or 
make such changes themselves.

 l Import: Gives users in this role the ability to import cost data.
 l Modify Forecast: Gives users in this role the ability to make changes to the forecast. This per-

mission setting will likely be restricted to project managers.

Documents tab
 l View All Sent Items: Gives users in this role the ability to see all of their sent items as well as the 

items sent by everyone else.

Equipment Items Tab
 l View Equipment Items: Gives users the ability to view the list of equipment items.
 l Add/Edit Equipment Items: Gives users the ability to add and edit equipment items.
 l Update Date Required on Job: Gives users the ability to update the date that items are required to 

be installed.

Funding tab
 l View Funding: Ability to see funding sources under the Project Cost.
 l Add / Edit Funding: Ability to Add a new funding source and complete deposits against the source.

Planning tab
 l View Planning Scenarios: Gives users in this role the ability to view planning scenarios. In some 

cases, there may be someone responsible for managing capital plan and another responsible for 
scenarios.

 l Modify Planning Scenarios: Gives users in this role the ability to add/edit planning scenarios.

Processes tab
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 l Manage Workflow: Gives users in this role the ability to manage process instances, which includes 
the right to override steps, update and take action on steps of the processes they have access to.

Projects tab
 l Update Project Details: Gives users in this role the ability to update project details, such as project 

name, the project administrator, address, project start and end dates, and project custom fields.

Schedule tab
 l View Schedule: Gives users the read-only ability to view the schedule from the Project menu. 

Note: This permission is available only for accounts with the current schedule enabled.

 l Manage Schedule: Gives roles or users the ability to add tasks and manage the schedule. This per-
mission is available only for accounts with the current schedule enabled. For more information, see 
Manage Schedule Tasks.

Note: When the Manage Schedule permission is enabled, the View Schedule permission will also 
be enabled by default. If the View Schedule permission is disabled, the Manage Schedule Per-
mission will also be disabled by default. However, changes to this permission will not cause any 
changes in the Manage Baselines permissions.

 l Manage Baselines: Gives users in this role the ability to create and delete baselines.

Note: Users with this permission can overwrite the baseline after it has been created and saved. 

Submittals tab
 l View Submittals: Gives users in this role the ability to view submittal items. When the View draft 

submittals setting is turned on, all team members who have the View Submittals permission will be 
able to see Submittal Register Items and Packages that are in Draft status.

 l Add/Edit Submittals: Gives users in this role the ability to add and edit submittal items.   This per-
mission should be given to contractors, as they will need to add, edit and send submittal items for 
review.

Time Tracking tab
 l Manage Project Bill Rates: Gives users in this role the ability to manage project bill rates. Although 

rates can be set at the account level, they can also be modified at the project level. Changes made 
on either page are reconciled and updated simultaneously. For instructions, see Manage Project Bill 
Rates.

Users tab
 l Manage Membership: Gives users in this role the ability to manage the projects that users are on 

and user roles.

Permissions By User Project Page 
This page allows account and project administrators to manage the permission settings for users and roles 
across all modules. Permission settings are critical for user access rights to certain features. When 
troubleshooting access rights, user and role permissions should be the first area of investigation to ensure 
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roles/users have appropriate access to product features. Typically, permissions are configured at the start of a 
project and as new project members are added on. However, as roles change and people move across depart-
ments, permissions should be updated accordingly.

The top portion of this page is a filter that you can use to narrow down the list of roles/users that display in the 
table below it. In edit mode, the second portion of this page lists all account roles, and then users. In view 
mode, only the list of users display. In e-Builder, account roles are used to group users, permission for both of 
which can be modified on this page. When managing user roles, it is important to ensure that each role is well 
defined and only includes those members that should have the access granted by that role's permissions. For 
instructions on adding account roles, see Add New Account Roles.

Note: Roles that appear in red are Administrator Roles. Administrator Roles are eligible to receive additional 
permissions typically reserved for the account administrator. For more information or for the list of additional 
permissions that can be granted, see About e-Builder Administrative Roles.

To filter by users
 1. In the Filter Users section, you can specify the following filter criteria:

 o User Name: Enter the username of the user to filter by.
 o First Name: Enter a name in this field to filter by a user's first name.
 o Last Name: Enter a name in this field to filter by a user's last name.
 o Select a custom field: Click the drop-down arrow to select a custom field type to filter by. 

 2. Click Filter. The filter results are displayed.

To access the  Permissions By User for Project
 1. On the top navigation tabs, click the Projects tab.
 2. Click the Project drop-down menu and select the project name. The Projects page is displayed.
 3. On the left navigation menu under Project Menu > Details > Permissions by User.

Permission Settings

A description of the permission settings available on each tab of this page is provided below:

Note: The asterisk indicates that users have to be in this role at the account level in order to inherit this per-
mission. In other words, this permission cannot be applied to a project level role. For more information, see 
About Project Level Roles.

Bidding 
 l View Bidding: Gives users the ability to view an entire bid package.
 l Create Bid Package: Gives users the ability to create bid packages.
 l Modify Bidding: Gives users the ability to modify bid package details.
 l View/ Open Bid Tabulation: Gives users the ability to view and open the bid tabulation.
 l Manage Templates: Gives users the ability to manage bidding templates.

BI Reports 
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 l View Report: Gives users the ability to view BI reports.
 l Add / Edit Report: Gives users the ability create and edit reports and dashboards.

Calendar 
 l Create Public Project Event: Gives users the ability to create public events. Everyone on a project 

is able to view public events, even if they are not an attendee of the event.
 l Create Public General Event: Gives users the ability to create public general events. Events are 

private by default.

Contacts 
 l View Contacts: Gives users in this role the ability to view all contacts and contact details stored 

globally, even if the contact is not associated with a project. 
 l View Project Contacts: Gives users the ability to view contact details for the projects they have 

access to. Project participants are able to view project-specific contacts without having access to the 
entire global contact list.
Example

If there are 50 people in company, but only five are working on a particular project, you may not 
want contractors to know every other contractor or A/E that you're working with.

 l Add/Edit Contacts: Gives users in this role the ability to add contacts, modify contact details and 
import contacts. 

Cost 

Note: Cost integrated processes do not abide by these settings. Permissions for cost processes are set 
on the process properties page. For more information, see Properties Tab Overview.

 l View Cost: Gives users the ability to view the overall cost summary and all cost related information 
on the projects they have access to.

 l Add/Edit Budget: Gives users the ability to add and edit approved budgets, funding and cash flow.
 l Add Budget Item: Gives users the ability to add budget line items to approved budgets and budget 

changes.
 l Approve Final Budget: Gives users the ability to approve the final budget.

Note: Users will not receive an email notification on approval requests unless the Notify user 
when approval requested setting is enabled in Cost Settings.

 l Approve Budget Changes: Gives users the ability to approve budget changes.
 l Add/Edit Commit: Gives users the ability to add and edit commitment changes.
 l Approve Final Commit: Gives users the ability to approve commitments.
 l Approve Commit Changes: Gives users the ability to approve commitment changes and change 

commitment line items.
 l Change Approved Commit Line Item: Gives users the ability to approve changes made to 

approved commitment line items.

Example

properties_tab_overview.htm
cost_settings_page.htm


Trimble Unity Construct

Page 39

If a commitment was accidentally saved against the Contingency budget line item, when it should 
have been saved toward General Costs, persons with this permission setting will have the ability 
to approve this change or make such changes themselves.

 l Add/Edit Actual: Gives users the ability to add and edit invoices.
 l Edit Retainage on Actual: Gives users the ability to manually edit item retainage amounts on com-

mitment items in the Draft or Received status. 
 l Approve Final Actual: Gives users the ability to approve invoices.
 l Change Approved Gen. Invoice Line Item: Gives users the ability to approve changes made to 

approved general invoice line items.

Example

If an invoice was accidentally added toward Contingency, when it should have been added to 
General Costs, persons with this permission setting will have the ability to approve this change or 
make such changes themselves.

 l Manage Templates: Gives users the ability to manage cost templates. This setting might be useful 
if the workload needs to be shared among various people or departments.

 l Modify Forecast: Gives users the ability to make changes to the forecast. This permission setting 
will likely be restricted to project managers.

 l Import: Gives users the ability to import cost data.

Documents 
 l View All Sent Items: Gives users in this role the ability to see all of their sent items as well as the 

items sent by everyone else.
 l Manage Quarantine: Gives users in this role the ability to manage the spam quarantine. See About 

Spam Filter for more information on this feature.
 l Import: Gives users in this role the ability to import document custom fields into one or more doc-

uments already within e-Builder. This can be used to provide a large amount of meta data to multiple 
documents using a single transaction.

Equipment Items 
 l View Equipment Items: Gives users the ability to view the list of equipment items.
 l Add/Edit Equipment Items: Gives users the ability to add and edit equipment items.
 l Update Date Required on Job: Gives users the ability to update the date that items are required to 

be installed.

Forms tab
 l Manage Form Instances: Gives users in this role the ability to close form instances or change the 

permissions on the instance.
 l Manage Form Types: Gives users in this role the ability to add, remove or modify fields on form 

types.
 l Import: Gives users in this role the ability to import form instance details.

Funding 
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 l View Funding: Gives users the ability to see funding sources under the Project Cost.
 l Add/ Edit Funding: Gives users the ability to add a new funding source and complete deposits 

against the source.

Planning 
 l View Capital Plan: Gives users in this role the ability to view capital plans. In some cases, there 

may be someone responsible for managing capital plan and another responsible for scenarios.
 l Modify Capital Plan: Gives users in this role the ability to add/ edit capital plans.
 l View Planning Scenarios: Gives users the ability to view planning scenarios. In some cases, there 

may be someone responsible for managing capital plan and another responsible for scenarios.
 l Modify Planning Scenarios: Gives users in this role the ability to add/edit planning scenarios.
 l Manage Templates: Gives users in this role the ability to manage planning templates.

Processes 
 l Manage Processes: Gives users in this role the ability to update process types without being an 

account administrator. 
 l Manage Workflow: Gives users the ability to manage process instances, which includes the right to 

override steps, update and take action on steps of the projects they have access to.
 l Import: Gives users in this role the ability to import process instance details.

Projects 
 l Manage Private Notes: Gives users the ability to view and add private project notes via the Project 

Details page - Notes tab.
 l Add New Project: Gives users in this role the ability to add new projects and apply project tem-

plates. Account administrators might choose this as an alternative to giving certain roles/ users full 
administrative rights. 

 l Update Project Details: Gives users the ability to update project details, such as project name, the 
project administrator, address, project start and end dates, and project custom fields.

 l Manage Project Level Field Options: Gives users the ability to manage project-level field options.

Schedule 
 l View Schedule: Gives users or roles the ability to view the Schedule module from the Project Menu, 

and to run reports on schedule information. Note that this permission will be available only for 
accounts with the Current schedule enabled. Accounts that still utilize the Classic Schedule inter-
face will not have this permission in the Setup module.

 l Manage Schedule:  Gives users the ability to add tasks and manage the schedule. For more inform-
ation, see Manage Schedule Tasks.

Note: When the Manage Schedule permission is enabled, the View Schedule permission will also 
be enabled by default. If the View Schedule permission is disabled, the Manage Schedule Per-
mission will also be disabled by default. However, changes to this permission will not cause any 
changes in the  Manage Baselines permissions.
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 l Manage Baselines: Gives users in this role the ability to overwrite the baseline after it has been cre-
ated and saved. This permission will most likely be restricted so that Project Managers are not re-
saving the baseline.

Submittals 
 l View Submittals: Gives users the ability to view submittal items.
 l Add/Edit Submittals: Gives users the ability to add and edit submittal items. This permission 

should be given to contractors, as they will need to add, edit and send submittal items for review.
 l Create Submittals: Gives users the ability to create submittal items but not send them for review. 

This is intended for subcontractors who submit items to a general contractor.
 l Manage Project Level Settings: Gives users the ability to manage submittal settings at the project-

level.

Time Tracking 
 l Create Time Sheets: Gives users the ability to create and submit time sheets. Please be aware that 

if users are submitting time for billable activities, bill rates must also be set for these particular activ-
ities to be enabled on the time sheet. For instructions, see Manage Account Bill Rates. 

 l Manage Workflow: Gives users in this role the ability to create, edit and delete workflows. The role 
must be an account admin role in order to receive this permission. Workflows are required to route 
submitted time sheets to the appropriate parties. For more information, see About Workflows. 

 l Manage Account Bill Rates: Gives users in this role the ability to manage account bill rates. Bill 
rates are required for billable activities. Users with this permission are able to set hourly rates per 
user. You can set a default rate at the account level and also specify rates for particular projects in 
the event they differ from project to project. Rates must be set in order for users to view billable activ-
ities on their time sheets. For more information, see Manage Account Bill Rates. 

 l Manage Project Bill Rates: Gives users in this role the ability to manage project bill rates. Although 
rates can be set at the account level, they can also be modified at the project level. Changes made 
on either page are reconciled and updated simultaneously. For instructions, see Manage Project Bill 
Rates.

 l View Payout: Gives users in this role the ability to view the payout amount on their time sheet, 
which includes their bill rate. Without this permission, users will only see the total amount of time 
entered per project and activity. For more information, see Your Time Sheet Page Overview. 

Sent Items Page 
The Sent Items page allows account and project administrators to view all outbound messages sent by project 
participants. Viewing sent items gives you access to the following sets of information:

 l Subject of the message
 l Date sent
 l Recipient(s)
 l Sender
 l Delivery address

manage_account_bill_rates.htm
about_workflows.htm
manage_account_bill_rates.htm
manage_project_bill_rates.htm
manage_project_bill_rates.htm
your_time_sheet_page.htm


Trimble Unity Construct

Page 42

 l Message status
 l Number of times the message was opened

For instructions on viewing sent messages, see View Sent Messages.

Fields and Buttons

The fields and buttons located on the Sent Items page are:
 l Cancel: Click to cancel the search and return to previously accessed page.
 l Project: Displays the name of the project you are in.
 l Project Number: Displays the project number, if available. Administrators have the ability to set project 

numbers by going to Setup > Projects > Project Settings. For instructions, see Create Project Number 
Custom Fields.

The fields and buttons in the Filter section are:
 l Show Failed Messages: Select this check box to include only failed messages in the filter results.
 l Sent To: You are able to search for a single user at a time. Enter the name of participant that messages 

were sent to.
 l Subject: Enter the subject of the messages you want to filter by.
 l Date Sent Between: To filter for messages sent with a certain time frame, enter the dates in these 

fields.
 l Body: Enter a single keyword or phrase contained in the body of the message to filter by. Avoid the use 

of commas.
 l Filter: Click to filter for entered criteria.
 l Reset: Click to clear filter text fields.

The fields and buttons in the Messages section are:
 l Subject: Displays the subject of the message. Click to open message details in a separate window.
 l Date Sent: Displays the date and time the item was sent.
 l To: Displays the Name, Email Address or Fax Number that the message was sent to. If the message 

was sent to multiple recipients, the word "Multiple"  displays as a link for you to view a full list of the recip-
ients and associated details.

 l Sent By: Displays the name of the person that sent the message.
 l Delivery Address: Displays the recipient's email address.
 l Status: Displays the status of the message. Multiple statuses may be available if the message was 

sent to multiple recipients. If there are multiple statuses, the word "Multiple" displays as a link for you to 
view the details of additional statuses.

 l # Times Opened*: Displays the number of times the message was opened. This number may be unre-
ported if the if recipient email client blocks images. If the message was sent to multiple people, the word 
"Multiple" displays as a link for you to view details.
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Project Level Options
The Project Level Options page allows administrators and users to set project level options for projects that 
have a Drop Down, Multiple Pick, Radio Button or a Checkbox data type selected. This is available for custom 
fields and Process Data Fields only. When configuring a field of one of these types, you will now have the abil-
ity to set the options at the:

 l Account Level
 l Project Level: Options can be different project by project

Fields and Buttons

The fields and buttons located on this page are:
 l Configure By: Select configuration by field or option type
 l Fields: Make a selection between custom fields or process data fields
 l Options: Unselected lists all options configured for this project, not selected for this field
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